Networking
Networking overview
Networking lets you connect your computer to other computers or a private network. When you connect your computer to a network or another computer, you can: 

Gain access to files and folders on other computers. 

Let other people gain access to your files and folders. 

Use printers and other devices that are connected to other computers. 

Let other people gain access to any printers or devices that are connected to your computer. 
There are many different ways to connect your computer to another computer or a network. Using Windows 2000, you can connect your computer to: 

Another computer using a direct cable connection. 

A private network using a modem or an Integrated Services Digital Network (ISDN) adapter or a network adapter card. 

A network using a virtual private network (VPN) connection. 

Another computer by having another computer call your computer. 
You can make these connections and configure networking protocols and settings using Network and Dial-up Connections, which can be found in the Control Panel. You can also connect to bulletin board services, networks, and other computers using the Telnet or HyperTerminal utilities. 
To make a dial-up connection by using a phone line
 1.
Open Network and Dial-up Connections. 
 2.
Double-click Make New Connection, and then click Next. 
 3.
Click Dial-up to private network, click Next, and then follow the instructions in the Network Connection wizard. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections. 

When you connect to a remote access server, you can access data files across the telephone line; you cannot run programs remotely. For most applications, running a program across a telephone wire is unacceptably slow. For the best performance, you should install licensed copies of the applications you need on your local computer. 
To make a dial-up connection by using an ISDN line
 1.
Open Network and Dial-up Connections. 
 2.
Double-click Make New Connection, and then click Next. 
 3.
Click Dial-up to private network, click Next, and then follow the instructions in the Network Connection wizard. 
Note

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections.
To make a local area connection

Typically, most Windows 2000 users belong to a local area network. When you start your computer, Windows 2000 detects your network adapter and automatically starts the local area connection. Unlike other types of connections, the local area connection is created automatically, and you do not have to click the local area connection in order to start it.
Notes

Windows 2000 automatically creates a local area connection for each network adapter that it detects. 

If more than one network adapter is installed, you can eliminate possible confusion by immediately renaming each local area connection to reflect the network that it connects to. 

If your computer has one network adapter, but you need to connect to multiple LANs (for example, when traveling to a regional office), the network components for your local area connection need to be enabled or disabled each time you connect to a different LAN. 

If more than one network adapter is installed, you need to add or enable the network clients, services, and protocols that are required for each local area connection. When you do so, the client, service, or protocol is added or enabled for all other network and dial-up connections. 
To make a virtual private network (VPN) connection 
 1.
Open Network and Dial-up Connections. 
 2.
Double-click Make New Connection, and then click Next. 
 3.
Click Connect to a private network through the Internet, and click Next. 
 4.
If you have already established a dial-up connection, do one of the following: 

If you need to establish a connection with your ISP or some other network before tunneling to your destination computer or network, click Automatically dial this initial connection, click a connection in the list, and then click Next. 

If you do not want to automatically dial an initial connection, click Do not dial the initial connection, and then click Next.
 5.
Type the host name or IP address of the computer or network to which you are connecting, and then click Next. 
 6.
Do one of the following: 

If you want this connection to be made available to all users on your network, click For all users, and then click Next. 

If you want to reserve the connection for your own use, click Only for myself, and then click Next.
 7.
If you want to let other computers access resources through this dial-up connection, select the Enable Internet connection sharing for this connection check box, and then click Next. 
 8.
Type a name for the connection, and then click Finish. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections. 

To make the connection available to all users, you must be logged on as Administrator or as a member of the Administrators group. 

You can create multiple VPN connections by copying them in the Network and Dial-up Connections folder. You can then rename the connections and modify connection settings. By doing so, you can easily create different connections to accommodate multiple hosts, security options, and so on. 
To make a direct network connection
 1.
Open Network and Dial-up Connections. 
 2.
Double-click Make New Connection, and then click Next. 
 3.
Click Connect directly to another computer, click Next, and then follow the instructions in the Network Connection wizard. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections. 

To create a direct network connection that acts as a host, you must be logged on as Administrator or be a member of the Administrators group. Guest direct network connections do not require administrator-level rights. 

If you specify your connection as a host when you create it, the connection appears as Incoming Connections in the Network and Dial-up Connections folder. 

You can create multiple direct connections by copying them in the Network and Dial-up Connections folder. You can then rename the connections and modify connection settings. By doing so, you can easily create different connections to accommodate multiple ports, host computers, and so on. 

Direct connections can bypass authentication requirements. This is useful for devices such as palmtop computers. You must configure this setting in the host incoming connection. 

If you create a direct connection by using a serial (RS-232C) cable, the port that you select in the Network Connection wizard is enabled for connections that use a null modem. 

If you are logged on to your computer as Administrator or a member of the Administrators group when you create a direct connection, you are presented with a list of connection devices to choose from that includes all of the parallel ports for the computer, infrared ports that are installed and enabled, and COM ports. If you are logged on as a user who is not a member of the Administrators group, and create a direct connection, the list of devices includes the parallel ports for the computer, infrared ports that are installed and enabled, and only the COM ports that are configured with null modems. If you need to use a COM port for a direct connection, ask your system administrator to configure one of the COM ports on your computer with a null modem by using Phone and Modem Options in Control Panel. 

Users do not need to use direct connections to allow access to shared resources, such as files and printers, over a local area network. In order to enable shared access to resources on the local computer, you must enable file and print sharing, share the resources, and then set up the appropriate permissions. 
To make an incoming network connection
 1.
Open Network and Dial-up Connections. 
 2.
Double-click Make New Connection, and then click Next. 
 3.
Click Accept incoming connections, click Next, and then follow the instructions in the Network Connection wizard. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections. 

If you make another incoming network connection, and you use the Network Connection wizard again, the existing incoming network connection is reconfigured. 

To create an incoming network connection, you must be a member of the Administrators group. 

For large numbers of incoming connections on a computer running Windows 2000 Server that operates as part of a distributed network or as a domain controller, use Windows 2000 Server Routing and Remote Access to create a remote access server. 

If your incoming connection and Fax Service have problems working together (for example, you cannot receive incoming connection calls on a device enabled for Fax receive), the modem may not support adaptive answer. Check your modem documentation to verify that you need to disable Fax receive for that device to accept incoming connections. 

If you connect to a computer running Windows 2000 Professional or stand-alone Windows 2000 Server that is configured for incoming connections, and you are running Windows 95 or Windows 98 and want to log on to the computer by using a local user account, you can use your Windows 95 or Windows 98 user name, domain, and password. When you connect, the computer running Windows 2000 replaces the Windows 95 or Windows 98 domain name with the local computer name when you provide your user name and password authentication information. 

Incoming connections are only used for dial-up, VPN, or direct connection clients. 
To disconnect from the network 
 1.
Open Network and Dial-up Connections. 
 2.
Right-click the connection you want to disconnect, and then click Disconnect. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections. 

If you disconnect a local area connection, it disables the network adapter driver until the connection is reactivated. 
To configure a connection 
 1.
Open Network and Dial-up Connections. 
 2.
Right-click the connection you want to configure, and then click Properties. 
 3.
Do one or more of the following: 

To configure dialing devices, phone numbers, host address, country/region codes, or dialing rules, click the General tab. 

To configure dialing and redialing options, multilink configuration, or X.25 parameters, click the Options tab. 

To configure identity authentication, data encryption, or terminal window and scripting options, click the Security tab. 

To configure the remote access server and protocols used for this connection, click the Networking tab. 

To enable or disable Internet connection sharing and on-demand dialing, click the Sharing tab. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections. 

Depending on the type of connection you are configuring, different options appear. For example, a local area connection only displays the General tab. 

For more information about a specific item on a tab, right-click the item, and then click What's This? 
To add a network component
 1.
Open Network and Dial-up Connections. 
 2.
Right-click the connection to which you want to add a network component, and then click Properties. 
 3.
Do one of the following: 

If this is a local area connection, click Install. 

If this is a dial-up, VPN, or incoming connection, on the Networking tab, click Install. 
 4.
In the Select Network Component Type dialog box, click either Client, Service, or Protocol, and then click Add. 
 5.
Do one of the following: 

If you do not have an installation disk for the component, click the appropriate client, service, or protocol, and then click OK. 

If you have an installation disk for the component, click the appropriate client, service, or protocol, click Have Disk, insert the installation disk into the selected drive, and then click OK. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections. 

You should only install the network components that you need, for the following reasons: 

Network performance is enhanced and network traffic is reduced when only the required protocols and clients are installed. 

If Windows 2000 encounters a problem with a network or dial-up connection, it attempts to establish connectivity by using every network protocol that is installed and enabled. By only installing and enabling the protocols that your system can use, Windows 2000 does not attempt to connect with protocols it cannot use, and returns status information to you more efficiently. 

Excessive services can hinder performance on your local computer. 
To install TCP/IP
 1.
Open Network and Dial-up Connections. 
 2.
Right-click the network connection for which you want to install and enable TCP/IP, and then click Properties. 
 3.
On the General tab (for a local area connection) or the Networking tab (all other connections), if Internet Protocol (TCP/IP) is not in the list of installed components, then do the following: 

Click Install. 

Click Protocol, and then click Add. 

In the Select Network Protocol dialog box, click Internet Protocol (TCP/IP), and then click OK. 
 4.
Verify that the Internet Protocol (TCP/IP) check box is selected, and then click OK. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections. 

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. 

TCP/IP is installed as the default network protocol if network adapter hardware was detected during Windows 2000 Setup. You only need to follow these instructions if the TCP/IP default selection was overridden during Setup. 
To install Client Service for NetWare
 1.
Open Network and Dial-up Connections in Control Panel. 
 2.
Right-click the local area connection for which you want to install Client Service for NetWare, and then click Properties. 
 3.
On the General tab, click Install. 
 4.
In the Select Network Component Type dialog box, click Client, and then click Add. 
 5.
In the Select Network Client dialog box, click Client Service for NetWare, and then click OK. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, click Control Panel, and then double-click Network and Dial-up Connections. 

When you install Client Service for NetWare, it is installed for all connections. If you do not want Client Service for NetWare installed for a certain connection, view the properties for that connection and then clear Client Service for NetWare. 

You cannot use Client Service for NetWare to interoperate with NetWare 5.x. Therefore, to interoperate in NetWare 5.x, you must run the IP/IPX gateway in NetWare 5.x, or use a redirector that is compatible with NCP and that supports native IP. 

To test that Client Service for NetWare has been initialized properly, at a command prompt, type net view /network:nw. You should see a list of available NetWare servers. 

When Client Service for NetWare is installed, the NWLink IPX/SPX/NetBIOS Compatible Transport protocol is also installed. 
To create a permanent virtual connection using ATM 
 1.
Open Network and Dial-up Connections. 
 2.
Click the ATM connection that corresponds to the ATM network adapter installed on this computer for which you want to create a permanent virtual circuit (PVC). 
 3.
Click File, and then click Properties. 
 4.
In the list of network components used in this connection, select ATM Call Manager, and then click Properties. 
 5.
In ATM Call Manager properties, click Add. 
 6.
Review and modify PVC settings as needed: 

For Name, you can either use the default unspecified PVC name or type a name. Both are used only for your reference. 

For Virtual path ID, you can either use the default path of 0 or type a number that should be used to identify the virtual path for the connection. 

For Virtual circuit ID, type a number that identifies the virtual circuit within the specified virtual path for the connection. 

In Application type, select the type of application or use for this permanent virtual connection. If you configured your IP/ATM connection for PVCs only, you must select the application type ATM ARP for this PVC. 
 7.
If needed, click Advanced to configure any settings that provide call or answer matching criteria for the PVC or that specify a quality of service for use with the PVC. 
Notes

To open Network and Dial-up Connections, click Start, point to Settings, and then click Network and Dial-up Connections. 

For additional information on an item, right-click the item, and then click What's This? 

PVCs are not required and are not typically recommended for building most types of ATM network connections. 
To install the SNMP service
 1.
Open the Windows Components wizard. 
 2.
In Components, click Management and Monitoring Tools (but do not select or clear its check box), and then click Details. 
 3.
Select Simple Network Management Protocol check box, and click OK. 
 4.
Click Next. 
Notes

To open the Windows Components wizard, click Start, point to Settings, click Control Panel, double-click Add/Remove Programs, and then click Add/Remove Windows Components. 

Certain Windows components require configuration before thay can be used. If you installed one or more of these components, but did not configure them, when you click Add/Remove Windows Components, a list of components that need to be configured is displayed. To start the Windows Components wizard, click Components. 

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings might also prevent you from completing this procedure. 

SNMP starts automatically after installation. 
To select an IPSec policy for a workstation
 1.
Open Network and Dial-up Connections. 
 2.
Click Local Area Connection, and on the File menu, click Properties. 
 3.
In the Local Area Connection Properties dialog box, under Components checked are used by this connection, click Internet Protocol (TCP/IP), and then click Properties. 
 4.
Click Advanced, and then click the Options tab. 
 5.
Under Optional settings, click IP security, and then click Properties. 
 6.
Click Use this IP security policy, and then select the IPSec policy you want from the drop-down list. 
Notes

You must be a member of the Administrators group to set Internet Protocol security (IPSec) policies. If the computer participates in a Windows 2000 domain, the computer may receive the IPSec policy from Active Directory, overriding the local IPSec policy. In this case, the options are disabled and you cannot change them from the local computer. 

To open Network and Dial-up Connections, click Start, point to Settings, click Control Panel, and then double-click Network and Dial-up Connections. 

There are three predefined security policies: Client (Respond Only), Server (Request Security), and Secure Server (Require Security). 

Activating the Client (Respond Only) policy will not secure traffic unless the destination computer requests it. A server policy may need to be customized to work transparently with some programs and networks. 

For in-depth information about IP Security and the predefined security policies, open the IP Security Policy Management snap-in, and then on the Help menu, click Help Topics. 

IPSec, IKE and related services for Windows 2000 are jointly developed by Microsoft Corporation and Cisco Systems, Inc. 
